DynaPro NanoStar
User’s Guide

(M3300 Rev. A)
WYATT TECHNOLOGY Corporation makes no warranties, either express or implied, regarding this instrument, computer software package, its merchantability or its fitness for any particular purpose. The software is provided "as is", without warranty of any kind. Furthermore, Wyatt Technology does not warrant, guarantee, or make any representations regarding the use, or the results of the use, of the software or written materials in terms of correctness, accuracy, reliability, currentness, or otherwise. The exclusion of implied warranties is not permitted by some states, so the above exclusion may not apply to you.

Copyright © 2009, Wyatt Technology Corporation. All rights reserved.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Wyatt Technology Corporation.

Wyatt Technology and the Wyatt Technology logo are registered trademarks of Wyatt Technology Corporation. DynaPro, Titan, Protein Solutions, and DYNAMICS are trademarks of Wyatt Technology Corporation.

A variety of U.S. and foreign patents have been issued and/or are pending on various aspects of the apparatus and methodology implemented by this instrumentation.
Contents

Chapter 1: About the DynaPro NanoStar
  1.1 Overview ................................................................. 1-1
  1.1.1 The Instrument ....................................................... 1-2
  1.1.2 The Software ......................................................... 1-2
  1.2 Using the DynaPro NanoStar ........................................ 1-3
    1.2.1 DynaPro NanoStar Operations ..................................... 1-4
  1.3 Using This Manual ..................................................... 1-5
  1.4 Contacting Wyatt Technology ......................................... 1-5

Chapter 2: Safety, Warnings, and Cautions
  2.1 Warning Signs on the Chassis ........................................ 2-2
  2.2 Electrical Specifications ............................................. 2-2
  2.3 Maintenance of Electrical Components ............................... 2-2
  2.4 Laser Safety Notes ..................................................... 2-3

Chapter 3: DynaPro NanoStar Components
  3.1 Front Panel View ........................................................ 3-2
  3.2 Back Panel View ........................................................ 3-3
    3.2.1 Changing a Fuse .................................................. 3-3
  3.3 Top Cover ............................................................... 3-4
  3.4 Temperature Control ................................................... 3-5
  3.5 Target Temperature .................................................... 3-6
    3.5.1 Setting Target Temperature ....................................... 3-6
    3.5.2 Automating Temperature Control .................................. 3-6
    3.5.3 Achieving a Stable Temperature .................................. 3-7
  3.6 Controlling Humidity .................................................. 3-8
    3.6.1 Nitrogen Purge Installation ...................................... 3-8
    3.6.2 Nitrogen sensor .................................................... 3-8
  3.7 Laser ................................................................... 3-9
    3.7.1 Laser Beam Warning ................................................. 3-9
    3.7.2 Laser Monitors ..................................................... 3-10
  3.8 Read Head and Detectors .............................................. 3-11
    3.8.1 Read Head Structure ............................................... 3-11
Contents

Chapter 6: Preparing Samples
  6.1 Cleaning the Cuvette ................................................................. 6-2
    6.1.1 Cleaning Tips .................................................................... 6-2
  6.2 Filtering Samples ................................................................. 6-3
    6.2.1 Filtering Options ............................................................ 6-3
  6.3 Spinning the Sample ............................................................. 6-4
  6.4 Filling the Cuvette ............................................................... 6-4
    6.4.1 Loading Tips .................................................................. 6-4
  6.5 Loading the DynaPro NanoStar ........................................... 6-5
  6.6 Sample Preparation Troubleshooting ..................................... 6-6

Chapter 7: Collecting Data
  7.1 Prepare and Fill Cuvette with BSA Sample ......................... 7-2
    7.1.1 Preparing the Cuvette .................................................. 7-2
    7.1.2 Filling the Cuvette ....................................................... 7-2
  7.2 Load the Cuvette into the DynaPro NanoStar .................... 7-3
  7.3 Wait for Equilibrium ............................................................ 7-3
  7.4 Check the Count Rates ......................................................... 7-4
  7.5 Record Data .......................................................................... 7-4
  7.6 Compare your Results .......................................................... 7-4

Chapter 8: Periodic Maintenance
  8.1 Cuvettes ................................................................................ 8-2
  8.2 Outer Case ............................................................................ 8-2
  8.3 Inlet Air Filters ...................................................................... 8-2
  8.4 Cooling Precautions ............................................................. 8-2

Appendix A: Laser Specifications .............................................. A-1
  A.1 Electrical and Optical Specifications .................................. A-1
  A.2 Environmental Specifications and Safety Notes .................. A-2

Appendix B: Connecting to Network or PC ................................ B-1
  B.1 Components ........................................................................ B-2
    B.1.1 Instrument connections: .............................................. B-2
    B.1.2 LAN connection: ....................................................... B-3
    B.1.3 Computer connections: ............................................... B-4
    B.1.4 Crossover cable: ......................................................... B-5
    B.1.5 Ethernet cable: ............................................................ B-6
    B.1.6 Ethernet to USB adapter: ............................................ B-7
    B.1.7 Ethernet switch: .......................................................... B-8
  B.2 Connecting to a LAN ............................................................. B-9
    B.2.1 One instrument to LAN: .............................................. B-9
    B.2.2 One instrument and computer to LAN: ....................... B-10
    B.2.3 Multiple instruments to LAN: ..................................... B-11
    B.2.4 Multiple instruments and computer to LAN: ................ B-12
  B.3 Connecting via USB ............................................................. B-13
    B.3.1 One instrument to USB via a crossover cable: ............. B-13
    B.3.2 One instrument to USB using an Ethernet switch: ....... B-14
    B.3.3 Multiple instruments to USB: ...................................... B-15

M3300 Rev. A
### Contents

B.4 Connecting via Ethernet when not on a LAN. ............................................ B-16
   B.4.1 One instrument to computer not on LAN using crossover cable: ............ B-16
   B.4.2 One instrument to computer not on LAN using an Ethernet switch: ........ B-17
   B.4.3 Multiple instruments to computer not on LAN using an Ethernet switch: ... B-18
B.5 Instrument Network Settings ..................................................................... B-19
B.6 Trouble-shooting and diagnostics ............................................................. B-20
   B.6.1 Verifying instrument connections .......................................................... B-20

### Index

<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Index-1
1 About the DynaPro NanoStar

This chapter provides a general introduction to the DynaPro NanoStar instrument and an overview of the sections in this manual.

CONTENTS
1.1 Overview ................................................................. 1-1
1.1.1 The Instrument ......................................................... 1-2
1.1.2 The Software .......................................................... 1-2
1.2 Using the DynaPro NanoStar ........................................... 1-3
1.2.1 DynaPro NanoStar Operations ..................................... 1-4
1.3 Using This Manual ....................................................... 1-5
1.4 Contacting Wyatt Technology ......................................... 1-5

1.1 Overview

The following is a brief description of the hardware and software that makes up the DynaPro NanoStar.

Figure 1-1: Temperature Controlled DynaPro NanoStar
Chapter 1: About the DynaPro NanoStar

1.1.1 The Instrument

The DynaPro is a combination Dynamic Light Scattering (DLS) and Static Light Scattering (SLS) instrument. The DLS detector operates at 90 degrees to measure the size distribution of the hydrodynamics radius, whereas the independent SLS detector, which also operates at 90 degrees, can measure the molecular weight of small molecules. DynaPro NanoStar can be used for a broad range of applications requiring both accuracy and high sensitivity. For example, the DynaPro NanoStar is ideally suited for studies of nanoparticles, proteins, vesicles, viruses, and colloids.

The DynaPro NanoStar is straightforward to operate. Knowledge of the underlying physics of molecular sizing is not essential. The block diagram below summarizes the basic operation of the DynaPro NanoStar.

![DynaPro NanoStar Block Diagram]

The sample is filtered to eliminate dust particles, which might interfere with the signal from the molecules being measured. Solutions are injected into cuvettes and placed into the sample cell. The total sample injection volume (including filtration) is approximately 20 µl using the 10 µl cuvette. After the cuvette is placed in the sample cell, the sample is illuminated by the laser. The scattered light is correlated in the DynaPro NanoStar, which then sends the results to the PC for analysis by the DYNAMICS software package.

1.1.2 The Software

DYNAMICS is data collection and analysis software for the DynaPro NanoStar molecular sizing system. Tuned specifically for characterization of unfractionated molecular samples, DYNAMICS applies sophisticated analysis tools to the quasi-elastic light scattering (QELS) data from the DynaPro NanoStar to give information on molecular sizes and sample polydispersity. The DYNAMICS software gives researchers the tools to quickly assess important sample properties without relying on chromatography or other fractionation techniques. Please refer to the DYNAMICS User’s Guide for specific information about the software.
1.2 Using the DynaPro NanoStar

Access to the sample cell is gained by sliding the top lid open. The sample cuvette (low-volume quartz cuvette) is inserted into the sample cell and the lid closed for measurements. Note that there is a safety switch connected to the lid that will disconnect the laser when the lid is open. Once the lid is closed again, the laser is re-enabled.

NOTE: Close the lid of the DynaPro NanoStar gently and slowly to avoid shaking the cuvette or sample. Do not slam the door.

If your sample is being measured near room temperature it will take about two minutes to reach thermal equilibration. If your sample is being measured at a high or a low temperature, several minutes may be required to reach thermal equilibration.

Prior to recording light scattering data, you must first establish communications between the DynaPro NanoStar and DYNAMICS by clicking the Connect to Hardware button in the DYNAMICS tool bar. When the connection between the DynaPro NanoStar and DYNAMICS is established, the DynaPro NanoStar’s laser is simultaneously enabled or turned on.

Once the instrument is connected, you can begin recording data by clicking the green Record button on the tool bar. The Record button face will then change to a flashing red, indicating that the software is in the recording mode. To stop recording data, click the flashing red Record button. For more information on recording data, see “Recording Data” in the DYNAMICS User’s Guide.

Cumulants and regularization analyses are applied automatically, the results of which can be viewed by selecting the appropriate view button on the Experiment Window.

Figure 1-3: Record Button
1.2.1 DynaPro NanoStar Operations

The sample is illuminated by a 120 mW air launched laser of ~ 658 nm wavelength. After laser intensity stabilization 100 mW is delivered to the sample cell. The light scattered by the sample is collected by two independent detectors: one for Static scattering and one for Dynamic scattering. The Static scattering detector is a silicon PIN photodiode, whereas the DLS detector is an actively quenched, solid state Single Photon Counting Module (SPCM). The photons are converted to electrical pulses and sent to a high speed multi-tau autocorrelator.

The DynaPro NanoStar analyzes the time scale of the scattered light intensity fluctuations by a mathematical process called autocorrelation. To perform the very fast data manipulation necessary to obtain results in real time, the DynaPro NanoStar uses the latest generation of correlator running special algorithms. The translational diffusion coefficient \(D_t\) of the molecules in the sample is determined from the decay of the intensity autocorrelation data. The hydrodynamic radius \(R_h\) of the sample is then derived from \(D_t\) using the Stokes-Einstein equation.

The DynaPro NanoStar determines the uniformity of sizes through a monomodal (single particle) curve fit analysis called cumulants, which assumes a particular size distribution, which is gaussian in decay rates (inversely related to size). We can extract an “average” size and a “polydispersity” which is related to the gaussian width of decay rates.

The SOS is the Sum Of Squares difference between the measured and the cumulants calculated intensity correlation curves, and is reported for each sample acquisition (a single correlation curve) in the Datalog Grid View of DYANAMICS. Low SOS values (< 20) indicate reasonable agreement between the measured correlation curve and the cumulants fitted curve, and suggest the sample is likely monomodal with low polydispersity, i.e. a tight size distribution.

Some samples will not be monomodal, but will contain multiple populations of different sizes. For these samples, you should expect to observe increased SOS values, e.g. > 100 (remember that the cumulants algorithm forces a single particle fit). If the sample appears to be multimodal, the size distribution histogram can be generated using the regularization algorithm, which makes no assumptions regarding the number of size populations.
1.3 Using This Manual

This manual is organized as follows:

Chapter 1, "About the DynaPro NanoStar": provides a general introduction to the DynaPro NanoStar instrument.


Chapter 4, "Installation and Setup"—Describes how to set up the DynaPro NanoStar instrument and install the DYNAMICS software.

Chapter 5, "Using the Display"—Describes how to use the front panel keypad and display of the DynaPro NanoStar.

Chapter 6, "Preparing Samples"—Describes how to prepare samples for light scattering measurements.

Chapter 7, "Collecting Data"—Provides a sample run for collecting data during a light scattering measurement.

Chapter 8, "Periodic Maintenance"—Provides maintenance and service instructions.

Appendix A, "Laser Specifications"—Provides electrical, optical, and environmental details for the GaAs laser.

Appendix B, "Connecting to Network or PC"—Describes the various network and PC connections which allow communication between the DynaPro NanoStar instrument and DYNAMICS software.

Index—Provides lookup assistance.

1.4 Contacting Wyatt Technology

We solicit and encourage questions and comments about this manual and the DynaPro NanoStar instrument. Please contact:

Wyatt Technology Corporation
6300 Hollister Ave.
Santa Barbara, CA, 93117

Telephone: (805) 681-9009
FAX: (805) 681-0123
E-mail: support@wyatt.com
Chapter 1: About the DynaPro NanoStar
As recommended by the American National Standards Institute, we have used icons along with messages to especially alert the user to potential hazards involved in this technology, following this standard:

**DANGER!**
Failure to follow, may result in injury or DEATH.

**WARNING!**
Failure to follow, may result in injury.

**Caution!**
Failure to follow, may result in damage to equipment.

**NOTE:** Additional information which may be of interest.

For best results and user safety, the following warnings and cautions should always be followed when handling and operating your DynaPro NanoStar.
2.1 Warning Signs on the Chassis

**DANGER!** 

DO NOT USE WITH FLAMMABLE SOLVENTS!

Using volatile solvents in the Temperature Controlled DynaPro NanoStar can create deadly vapors, fire, and explosions.

**Caution!**

The DynaPro NanoStar read head, cuvette, and other components can reach temperatures hot enough to cause serious burns.

Wear heat resistant gloves and exercise extreme caution when removing or replacing the cuvette.

2.2 Electrical Specifications

**DANGER!**

The power supply provided with your DynaPro NanoStar is designed to convert high voltage to the level required for operation. Do not open the power supply or defeat any of its safety interlocks. Serious injury or Death may result.

2.3 Maintenance of Electrical Components

**DANGER!**

The DynaPro NanoStar has no user serviceable parts. For your safety, do not dismantle the instrument.

Do not bypass any of the safety systems and interlocks that are in place for your health.

If the instrument is not functioning properly, do not apply power.
The lasers used in the DynaPro NanoStar are Class IIIb lasers. However, the DynaPro NanoStar itself is classified as a Class 1 Laser Product according to IEC60825-1:1993+A1+A2 and CFR Title 21 Subchapter J. Note these environmental specifications apply to the laser subsystem and not to the instrument as a whole. This means that under normal operation, no laser radiation should escape from the instrument, and no protective equipment must be worn. However, the following caution applies:

Caution! Use of controls or adjustment or performance of procedures other than specified herein may result in hazardous radiation exposure.

The instrument also bears the following warning label.

NOTE: All safety labels are in English. If you need safety labels in a language other than English, please contact Wyatt Technology.
This chapter provides a general introduction to the DynaPro NanoStar temperature controlled instrument.

**CONTENTS**

3.1 Front Panel View ................................................................. 3-2
3.2 Back Panel View ................................................................. 3-3
   3.2.1 Changing a Fuse .......................................................... 3-3
3.3 Top Cover .......................................................... 3-4
3.4 Temperature Control ......................................................... 3-5
3.5 Target Temperature ........................................................... 3-6
   3.5.1 Setting Target Temperature ............................................ 3-6
   3.5.2 Automating Temperature Control .................................... 3-6
   3.5.3 Achieving a Stable Temperature ...................................... 3-7
3.6 Controlling Humidity .......................................................... 3-8
3.7 Laser .......................................................... 3-9
   3.7.1 Laser Beam Warning .................................................... 3-9
   3.7.2 Laser Monitors .......................................................... 3-10
3.8 Read Head and Detectors .................................................... 3-11
   3.8.1 Read Head Structure ................................................... 3-11
3.1 Front Panel View

The front panel (see Figure 3-1) contains the main power switch (On/Off), the display window for monitoring data, keypad controls for operating the instrument, and provides cuvette storage inside the door.

**Figure 3-1: DynaPro NanoStar Front Panel**

**LCD Display:** The LCD display allows you to monitor, control, and configure the DynaPro NanoStar. Chapter 5, "Using the Display" describes the functions of the tabs available on the LCD display.

**Keypad:** The keypad allows you to control the LCD display. "Navigating the Display Panels" on page 5-2 describes how to use the keypad.
3.2 Back Panel View

The back panel contains the AC power module, ethernet connector, nitrogen purge connector, correlator input for Wyatt QELS, and cooling fans. The main power fuses are located in the AC power module and are described below.

3.2.1 Changing a Fuse

What you need to change a fuse:

- Tool for prying the AC Power module cover off, such as a small-bladed screwdriver.
- Fuses from the spares supplied in the accessory kit.

To replace the fuses, do the following:

1. Disconnect the power cord.
2. Open the cover of the AC Power module using a small blade screwdriver or similar tool.
3. Replace the burned out fuse with a 4 amp, 250V slow blow fuse. The fuse block contains two fuses. Both of them must be installed for the instrument to operate correctly.
4. Replace the cover of the AC Power module and reconnect the power cord.
3.3 Top Cover

The sliding door includes a magnetic proximity switch which disables the laser when the door is open.

Figure 3-4: DynaPro NanoStar with Door Open

Caution!

The DynaPro NanoStar read head, cuvette, and other components can reach temperatures hot enough to cause serious burns.

Wear heat resistant gloves and exercise extreme caution when removing or replacing the cuvette.
3.4 Temperature Control

The DynaPro NanoStar instrument actively controls the temperature within the sample cell. The range of temperature control is +4 to +150°C. The temperature can be maintained indefinitely between these extremes with an accuracy of better than 0.01°C.

The temperature control system uses a Peltier effect heat pump, which requires no heat exchanging radiators or chambers. The only moving parts are cooling fans. The cooling fans will run continuously whenever power is applied to the DynaPro NanoStar.

The DynaPro NanoStar can reach temperatures hot enough to cause serious burns. The following caution is shown on the display any time the door is opened while the DynaPro NanoStar is heated.
3.5 Target Temperature

When power is applied to the DynaPro NanoStar, the current temperature of the sample cell and the temperature set point, which you define, are shown on the Main panel and the System panel of the DynaPro NanoStar Display. The target temperature will be the last value entered from the previous session. The default target temperature from the factory will be +20 Celsius. When the temperature controller identifies a difference between the sampling chamber temperature and the target temperature, it will either cool or heat the chamber until the values match. It will continue to do this, as long as power is applied to the instrument. The temperature lock algorithm requires that the sample cell must be within 0.05°C of the set point for 120 seconds for the temperature lock alarm to turn green. Every time the door is closed, the temperature lock timer is restarted.

The color of the temperature field will change to Green to indicate that the temperature is locked. When the temperature field is Yellow, it is ramping and has not stabilized. When the temperature field is Green the sample should be at temperature and ready to take data. It may take a couple minutes for the cuvette and sample fluid to reach the temperature set point.

3.5.1 Setting Target Temperature

You can set the target temperature manually on the equipment or remotely using DYNAMICS software.

- On the front panel Display of the DynaPro NanoStar, set the target temperature manually on either the Main panel or the System panel. Refer to “Main Panel” on page 5-4 or “System Panel” on page 5-11.
- To control the target temperature remotely using DYNAMICS, open Instrument in the Parameters node. Enter a value for Set Temp (C). For more information on setting parameters, see Chapter 4, “Setting Parameters” in the DYNAMICS User’s Guide.

3.5.2 Automating Temperature Control

You can automate temperature control for sampling sequences using the Event Schedule feature in DYNAMICS.

1. Right click on the Parameters node and select Event Schedule.
2. From the Event menu, select Set Temp (C).
3. Under Variable, set the temperature and click Add.

You can program an arbitrary series of temperature set points as well as temperature ramp rates using DYNAMICS. For more information on setting parameters, see Chapter 5, “Automating Experiments” in the DYNAMICS User’s Guide.
3.5.3 Achieving a Stable Temperature

The DynaPro NanoStar instrument ramps at approximately 15 degrees per minute, so it should take roughly 10 minutes to get from +4°C to 150°C. This period of time assumes an external ambient temperature of approximately 25°C. If you notice longer stabilization time periods, please contact technical support at Wyatt Technology. In practice, it takes only a few minutes to reach and stabilize target temperatures.

Air circulation is maintained by inlet fans which exhaust air through ducts on the bottom of the enclosure. Do not allow these ducts to become obstructed in any way or the performance of the instrument may be impaired.
3.6 Controlling Humidity

A nitrogen purge connector is included on the DynaPro NanoStar. The nitrogen purge is used for condensation control when the DynaPro NanoStar is operated below 20°C. The nitrogen purge system is controlled by the microprocessor which sets the gas flow to high any time the lid is open (for example, during sample loading). The gas flow is set to low when the lid is closed. The nitrogen pressure is also monitored by the microprocessor to insure that even when the nitrogen tank runs out, no water will condense on the sample cell.

The temperature controller will not allow you to set a temperature below 20.5°C unless it detects at least 20 psi of gas pressure on the nitrogen port. This prevents accidental condensation on the cell and read head.

**NOTE:** With the door closed (operating below 20°C), the system will exhaust a standard nitrogen tank in about a month. With the door open, it will empty a tank in a day. Therefore to conserve nitrogen gas you should not leave the door open while operating below 20°C.

Anytime the instrument is operating above +20°C, based on the temperature set point, nitrogen purge is turned off. If you intend to use the NanoStar between 20°C and 150°C only, you do not need to connect nitrogen.

3.6.1 Nitrogen Purge Installation

While the instrument is warming up, attach a filtered dry air or oil-free grade nitrogen line to the nitrogen purge connector on the back of the DynaPro NanoStar. Use the 90-degree fitting and the 10-inch Polyethylene tubing provided. The dry gas will flow into the cell chamber and will prevent condensation in the cell. The pressure in the dry air or nitrogen line should be between 25 psi and 80 psi, depending on the local humidity. (At operating temperatures above 20°C, the nitrogen purge line is not required, but there is no harm in leaving it plumbed. The internal valves will remain closed and no gas will be consumed.)

3.6.2 Nitrogen sensor

The nitrogen sensor measures the pressure of the N2 port. This is used to determine if a source of dry gas is connected for operation below ambient, or if the gas cylinder has emptied.

N2 pressure alarm is triggered when the temperature is set to less than 20°C, but the nitrogen pressure is less than 20 psi. In this case, the alarm activates and resets the system temperature to 20.5°C. This prevents condensation from damaging the optics if the nitrogen connection is not made, or if the tank runs empty.
3.7 Laser

The 100 mW air launched laser provides the light source for the system. The laser provides very high power density at the illuminated sample by means of a narrow beam diameter (the $\frac{1}{e^2}$ diameter of the Gaussian beam profile is 0.08 mm). This small beam diameter also helps reduce the noise contributions of larger particulate contaminants (such as dust). The laser is oriented so that the incident beam is vertically polarized. A beam monitor (laser monitor) is incorporated into the laser assembly. The output of this monitor can be displayed on the Main panel on the display.

3.7.1 Laser Beam Warning

Under normal operating conditions the laser beam is entirely contained within the read head. A laser interlock ensures that when the instrument door is opened, the laser is disabled.

Caution!

Do not attempt to defeat laser interlocks.
Do not insert finger or mirror into sample cell cavity for any reason.

Refer to Appendix A for laser specifications.
3.7.2 Laser Monitors

The software uses the laser monitor signals to normalize the scattering signals relative to incident laser beam power. The method involves splitting the beam at its source and dividing background corrected values by the split signal. The normalization factor $I_0$—the incident intensity, is proportional to the beam emitted from the front of the laser and is obtained from the beam splitter on the laser assembly. The Laser Monitor and the Forward Monitor signals are displayed as a percentage of intensity. Zero percent means no light is detected. If the Laser Monitor signal differs from the Laser Power set point by more than 10% the Laser Monitor alarm will activate. The laser may have reached the end of its useful lifetime. Please contact technical support at Wyatt Technology.

- The Laser Monitor measures the intensity of the beam at the laser assembly before it enters the cell.

- The Forward Monitor enables the DynaPro NanoStar to measure transmitted light through the sample cell and sample. The primary usage of the forward monitor is simply as a diagnostic tool to determine if there are bubbles or other foreign particles in the cell. This signal is useful for measuring absorbing samples, which attenuate the beam intensity. The forward monitor measures the attenuation and can be used to determine the actual intensity at the center of the cell, where the scatter is measured.

- Laser Drive Current signal is used to gauge the lifetime of the laser. As the laser ages, the current required to provide a constant intensity slowly increases. The laser current is measured in mA and its initial value is recorded on the Certificate of Performance (COP) delivered with the instrument. When the current reaches a value of 30% higher than the initial value, the DynaPro NanoStar will switch from an intensity mode, to a constant current mode. In the constant current mode, the laser intensity will begin to decrease and the signal to noise ratio will begin to degrade. The instrument will still provide accurate data, but it indicates that the laser is nearing its maximum usable lifetime and the instrument should be serviced. The DynaPro NanoStar also measures Laser Voltage, which is a diagnostic that Wyatt Technical Service can use to track laser ageing.
3.8 Read Head and Detectors

In the read head (Figure 3-6), the sample cell is held precisely, scattered light is collimated, and the detectors are aligned in their proper positions.

3.8.1 Read Head Structure

The DynaPro NanoStar has two light scattering detectors, both at 90 degrees to the beam. One is used for static scattering, and one is used for dynamic scattering. The static scattering detector is a silicon PIN photodiode, which is used because it has low noise and a wide dynamic range. The static scattering detector creates an analog signal which is measured by a 24-bit analog-to-digital converter at a rate of 1 sample/second.

The dynamic light scattering detector uses a single photon counting module to measure the time fluctuations of the scattering signal. This high speed detector can operate at up to 15 MHz and feeds the photon counts to a high speed digital correlator.

The read head structure holds the two detectors and the photodiode with low gain amplifier for the Laser Forward Monitor detector, limits the sample field of view at the detectors, and minimizes stray light effects by means of its special structure. Since each detector's field of view is limited
by its own collimator, only the center of the illuminated sample scatters light into a given detector. A heavy aluminum mounting plate supports both the laser and the read head providing a single, stable optical bench.

The optics have been aligned at the factory and need no adjustment. The DynaPro NanoStar Electronics Module converts the analog signals from the detectors to digital values with individual 24-bit analog to digital converters. Note that the instrument’s major components are mounted on the steel sub-chassis, which also contains all power supplies (laser, meters, electronics) and fan assembly.
This chapter describes how to set up the DynaPro NanoStar instrument and install DYNAMICS software.

CONTENTS
4.1 Unpacking the DynaPro NanoStar ........................................... 4-1
4.2 Installing DYNAMICS Software .............................................. 4-2
  4.2.1 System Requirements ................................................... 4-2
  4.2.2 User Accounts with Restricted Privileges ....................... 4-2
  4.2.3 CD Contents ........................................................... 4-2
  4.2.4 Installing the Software ............................................. 4-3
4.3 Installing the Instrument .................................................. 4-4
4.4 Checking Initial Hardware Configuration ............................ 4-6
4.5 Calibrating DynaPro NanoStar ........................................... 4-7
4.6 Connecting DYNAMICS to DynaPro NanoStar ..................... 4-8
4.7 Verifying Hardware and Experiment Parameters .................. 4-10

4.1 Unpacking the DynaPro NanoStar

Please read the shipping parts list (packing slip) included with your instrument shipment and check that everything arrived in good condition.

1. Carefully examine the shipping container. If it is damaged or shows signs of mishandling,
   CONTACT WYATT TECHNICAL SUPPORT IMMEDIATELY.

2. Unpack the instrument.

3. Place the DynaPro NanoStar on a level surface and inspect the cabinet for damage. If you see any damage,
   CONTACT WYATT TECHNICAL SUPPORT IMMEDIATELY.

4. Check that the boxes contain all of the items listed as included with your instrument shipment in addition to the instrument (the packing slip sent with the instrument contains the most up-to-date list).
4.2 Installing DYNAMICS Software

DYNAMICS must be installed prior to connecting the DynaPro NanoStar to the PC.

4.2.1 System Requirements

As of the date of publication of this manual, the minimum system resources DYNAMICS requires are listed below. For current DYNAMICS system requirements please refer to our website; http://www.wyatt.com/solutions/software/system_requirements.cfm.

- Windows® XP Professional 32-bit edition or Windows 2000 Service Pack 2 or higher, with Internet Explorer version 5.5 or higher
- Pentium IV or better processor
- 2 GHz or better processor speed
- 512 MB of RAM or better (1GB recommended)
- At least 75 MB of available hard-disk space
- CD-ROM Drive (optional for installation)
- Ethernet connection to a network

4.2.2 User Accounts with Restricted Privileges

If DYNAMICS is to be run from a user account with restricted privileges, it is necessary to install DYNAMICS under the account to be used. If DYNAMICS is installed globally, you must have Windows Power User privileges to run DYNAMICS.

4.2.3 CD Contents

Your installation CD includes the following items required to control the DynaPro NanoStar.

- DYNAMICS software files
- PDF file of the DYNAMICS User's Guide
- PDF file of the DynaPro NanoStar User's Guide for your hardware configuration
- Software drivers related to the USB interface
- Additional software utilities
4.2.4 Installing the Software

Install the software as follows:

1. Restart your computer to ensure that no other programs are running, and that any previously installed DYNAMICS components are not running.

2. Insert the DYNAMICS CD in your CD drive. On most systems, the DYNAMICS setup procedure will start automatically.
   
   If the setup procedure does not start automatically, use Windows Explorer or the Run dialog to run the setup.exe file in the DYNAMICS folder on the CD.

3. Answer the prompts in the setup procedure.

4. To verify installation of DYNAMICS, open the Windows Start menu and look for Programs→Wyatt Technology→DYNAMICS 6.x.x.
4.3 Installing the Instrument

Once the software is installed on the PC, place the instrument within easy reach and viewing distance to the PC. Securely locate the DynaPro NanoStar on a stable lab bench free from excessive vibration, with approximately one foot of space on one side for sample preparation.

NOTE: Make sure the DynaPro NanoStar is not located in direct sunlight. Best data will be achieved if the environment is stable to ± 1°C or better at an ambient temperature of 4°C to 40°C non condensing.

To install the DynaPro NanoStar, do the following:

1. Place the instrument on a flat, clean surface, standing on its feet and positioned to allow air flow through the back to keep its electronics cool. (See Chapter 8, “Periodic Maintenance” for more information about the required environment and how to keep the DynaPro NanoStar in peak condition.)

NOTE: Warm air is exhausted through the bottom of the DynaPro NanoStar. Do not stack the instrument on top of any temperature sensitive equipment.

2. Make sure the supplied power plug is correct for the local power outlet. The DynaPro NanoStar is equipped with a universal power supply, which operates anywhere in the world. It accepts inlet voltages between 90-250V and line frequencies from 50-60Hz.
Installing DYNAMICS Software

3. Connect one end of the supplied ethernet cable to the ethernet port on the back of the DynaPro NanoStar and the other end to your local area network. Alternatively, you can use the optional ethernet-to-USB converter and connect to a USB port on the host computer.

When the DynaPro NanoStar is on the local area network, it may be accessed and controlled from any machine on the network. When using the USB converter, it can be accessed only by the host computer. See Appendix H for more details about implications for network security from the two different configurations.

4. Without a cuvette installed, switch on the laser from the front panel. The instrument should default to auto attenuation mode which will optimize the laser power and the fiber attenuation to maximum sensitivity. With no cuvette, it should default to 100% power and zero percent attenuation. This can be verified on the System tab. If the auto attenuation is turned off, it can be re-enabled on the System tab.

5. For Nitrogen Purge on Instruments operating below 20°C:
While the instrument is warming up, attach a filtered, dry, oil free grade nitrogen line to the Nitrogen Purge connector on the back of the DynaPro NanoStar. Use the 90-degree fitting and the 10-inch Polyethylene tubing provided. The dry gas will flow into the sample cell and will minimize condensation in the sample cell. The pressure in the nitrogen line should be between 25 psi and 80 psi, depending on the local humidity.
Chapter 4: Installation and Setup

4.4 Checking Initial Hardware Configuration

Prior to collecting light scattering measurements, DYNAMICS must be connected to the DynaPro NanoStar.

To verify proper loading of the hardware parameters into the DYNAMICS software, select Tools→Hardware and examine the fields for the correct serial number and configurations of your DynaPro NanoStar.

1. Connect your DynaPro NanoStar and power it on.
2. Start DYNAMICS and choose Tools→Hardware.
3. In the Edit Hardware screen, click Detect.

4. In the Instrument Detection screen, choose your instrument and click OK.
5. Click Save in the Edit Hardware screen.
6. If a screen appears that says: The optics block specified already exists. Do you wish to overwrite these setting?, click Yes.
7. Exit the Edit Hardware screen.
4.5 Calibrating DynaPro NanoStar

The DynaPro NanoStar is shipped with a Certificate of Performance (COP) to verify that the instrument was not damaged during shipping. You can prepare a toluene sample and calibrate using the procedure described in the DYNAMICS User's Guide.

1. Using the supplied DYNAMICS software, perform the appropriate steps to configure the instrument to communicate with the software.

Note: The laser in the DynaPro NanoStar is software controlled and can be turned on and off from the main page.

2. After establishing communications, wait at least 30 minutes for the laser to warm up and stabilize.
   * The forward monitor is calibrated to 100% power with Toluene in the cell. With the cell removed, the forward monitor will read greater than 100% since there are no reflection losses. The laser monitor measures the intensity of the laser before the beam enters the cell. The laser's intensity is controlled via a feedback loop based on the laser monitor signal (see “System Panel” on page 5-11). The forward monitor measures laser intensity after the beam has passed through the sample. This value will be affected by absorption of the sample as well as reflection losses from the cuvette windows. Since the beam passes through many optical surfaces and fluid, the forward monitor is not nearly as stable as the laser monitor and therefore is used primarily as a diagnostic signal. For example, when performing measurements, the forward monitor is used to detect the presence of bubbles or foreign matter in the sample.

3. Calibrate the DynaPro NanoStar using the DYNAMICS software.
   Prepare a toluene sample using chromatography grade toluene and 0.02µm Anatop filters. It is important the cell be clean and dust free for correct calibration. Filtered dusting gas is recommended.
   See the DYNAMICS User's Guide for instructions to configure communication with the instrument and perform the calibration measurement.

4. Compare your calibration result with the value from the Certificate of Performance.
   Your calibration result should be within 5% of the value on the Certificate of Performance.
4.6 Connecting DYNAMICS to DynaPro NanoStar

When you create a new experiment to collect data, DYNAMICS will automatically retrieve the unique hardware settings associated with your DynaPro NanoStar. If you are presented with the Original Hardware dialog when creating a new experiment, select Cancel. Then recheck the instrument connections and try to create a new experiment again. It is during this stage that the software autodetects the hardware settings.

1. Start a New Experiment.

To open a new Experiment Window, do one of the following:
- Click the page icon on the main tool bar.
- Select File→New from the main menu.

Figure 4-3: Starting a New Experiment

The Experiment Window is displayed. If this is the first time the software has been used, the default experimental settings are the factory settings.

Figure 4-4: Connecting DYNAMICS to the DynaPro NanoStar
2. Click the Green \( \text{Connect to Hardware} \) button located on the DYNAMICS toolbar.

When you click the Connect to Hardware button, DYNAMICS places new data into the current experiment file. Because the software can create more than one experiment, and more than one experiment can be opened at a time, it is necessary to instruct the software where to place new data. Additionally, Connect to Hardware verifies that the communications between the PC and DynaPro NanoStar are functioning properly.

If the Connect to Hardware is successful, the Record Button becomes Green. The Status box will notify you of the status of the communications verification, reporting any errors.
4.7 Verifying Hardware and Experiment Parameters

Prior to recording data, the proper hardware must be selected, particularly when the DynaPro NanoStar has multiple optical compartments. Click the Hardware branch in the Tree View, select Hardware, and view the settings in the properties table on the right-hand side. Use the drop down arrows to change hardware configurations.

Also, select the Parameters branch and review each branch. These parameters are described in detail in the DYNAMICS User's Guide.

![Figure 4-5: Verifying Hardware](image)
This chapter describes how to navigate and change settings in the DynaPro NanoStar Display.

CONTENTS
5.1 Navigating the Display Panels ........................................ 5-2
5.1.1 Front panel button description ....................................... 5-2
5.1.2 Instrument Alarm Status .............................................. 5-3
5.1.3 Audio Alarm ............................................................ 5-3
5.2 Main Panel ........................................................................ 5-4
5.2.1 Selecting Display Settings for the X, Y Axes ....................... 5-4
5.2.2 Adjusting the Display Range ......................................... 5-5
5.2.3 Setting Cell Temperature ............................................. 5-6
5.2.4 Laser ............................................................................ 5-6
5.3 QELS Panel ........................................................................ 5-7
5.3.1 Count Rate ................................................................. 5-7
5.3.2 Correlation Function .................................................... 5-8
5.3.3 Integration Time .......................................................... 5-8
5.3.4 APD Status .................................................................... 5-9
5.4 Alarm Panel ........................................................................ 5-10
5.5 System Panel ....................................................................... 5-11
5.5.1 Cell Temperature .......................................................... 5-11
5.5.2 Attenuator ...................................................................... 5-11
5.5.3 Auto Attenuate ............................................................. 5-11
5.5.4 Laser Power (%) .......................................................... 5-12
5.5.5 Set Time ......................................................................... 5-12
5.5.6 Language ....................................................................... 5-12
5.5.7 Zero Dark Offsets ........................................................... 5-12
5.5.8 Restart ISI ...................................................................... 5-12
5.5.9 Load Factory Defaults ................................................... 5-12
5.5.10 Restart Instrument ....................................................... 5-12
5.6 Comm Panel ....................................................................... 5-13
5.1 Navigating the Display Panels

You navigate through the Display Panels using the buttons to the right of the Display.

![Main display panel](image)

**Figure 5-1: Main display panel**

### 5.1.1 Front panel button description

- **Esc**-left and **right arrows** navigate through the Panel tabs.
- Esc and the number of the Panel tab (1 through 5) selects the first field in that Panel.
- **Tab** cycles through various fields in the current Panel.
- **Esc-Tab** selects the first field in the current Panel.
- **Enter** displays the options of the selected field with the current option selected. Use the arrow keys to change the option, and then Enter to select.
- If the field is a check box, **Enter** toggles the option.

**NOTE:** If you miss a field, press Esc and restart Tabbing through the fields.
5.1.2 Instrument Alarm Status

The instrument alarm status indicator will light to indicate operating conditions or hazards that may need your attention. Refer to “Alarm Panel” on page 5-10.

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>Not ready</td>
</tr>
<tr>
<td>Green</td>
<td>Ready</td>
</tr>
<tr>
<td>Red</td>
<td>Hazard</td>
</tr>
</tbody>
</table>

5.1.3 Audio Alarm

The DynaPro NanoStar will sound an audible alarm when a potential hazard is detected. Hazards include:

- vapor or liquid leak is detected
- an over temperature condition is detected

To turn off the audible alarm:
- Display the Alarm panel. Tab to the Audio Alarm checkbox and press Enter to uncheck the Audio Alarm box.

To enable the audible alarm:
- Press Enter again to check the Audio Alarm box.
5.2 Main Panel

The Main panel contains the most commonly used DynaPro NanoStar functions. The display shows graphical representations of two of the data streams collected by the instrument. One data stream is displayed in red on the right axis and other is displayed in blue on the left axis.

5.2.1 Selecting Display Settings for the X, Y Axes

You can select the data channel you want displayed in each axis.

![Figure 5-2: Main panel](image)

**Left and Right Y-axis Selectors**

- Tab to the field and press Enter to display the data channels.
- Use the up and down arrow keys to scroll through the parameters. Press Enter to select.

The left Y-axis data channel displays in blue; the right Y-axis data channel displays in red.

**X-axis Selector**

The X-axis selector sets the time range from 10 minutes to 2 hours. To change the time, see the Set Time field under "System Panel" on page 5-11.
5.2.2 Adjusting the Display Range

You can adjust the range displayed in the graph in a variety of ways. This also applies to the Set Scale button in the Batch Panel.

To use the zoom and pan buttons:

1. Tab to the Set Scale button.
   
The zoom/pan buttons are displayed.
2. Press the left arrow to zoom in.
3. Press the right arrow to zoom out.
4. Press the up arrow to pan up.
5. Press the down arrow to pan down.

Figure 5-3: Zoom and pan buttons
To change the scale numerically:
1. Tab to the Set Scale button.
2. Press Enter.
   The Set Scale dialog is displayed.
3. To toggle positive and negative, tab to the +/- button and press Enter.
4. To change values, tab to the Max field and enter a value.
   Tab to the Min field and enter a value. Press Enter.

Autoscale
Changes the scaling so the display fills the window.

5.2.3 Setting Cell Temperature
You set the cell temperature by using the numeric keypad to enter the value. The DynaPro NanoStar controls the temperature to within an RMS noise level less than 0.01°C of the set temperature.

5.2.4 Laser
Sets the laser to on or off. When the laser is off, the button is yellow with the word OFF to denote that the system is not ready to take data. When the laser is on, the button is green with the word ON to denote normal operation.

NOTE: Although the laser may be switched on, it may be set to a low intensity on the System Panel. Similarly, the fiber attenuator may be set to 100%. If the laser signals are low, check the System Panel settings, or put the system into Auto Attenuate mode. See “System Panel” on page 5-11.
5.3 QELS Panel

This section describes the QELS Panel in the DynaPro NanoStar display.

5.3.1 Count Rate

The Count Rate contains the raw signals for each of the light-scattering detectors and the photon count rate for the QELS detector.

Time

The Time field sets the time range of the X-axis.

![Count Rate Graph](image)

*Figure 5-5: Count Rate*
5.3.2 Correlation Function

The Correlation Function displays the intensity correlation curve for a single slice of QELS data, which is the raw dynamic light scattering data from which the hydrodynamics properties are derived.

The QELS measures the correlation function, which is a statistical measurement of how the scattered intensity fluctuates. It is a function of $\tau$, which is a time difference. For large values of $\tau$, the correlation function approaches 1.0, indicating that the light intensity at time $t$ is uncorrelated to the intensity at time $t + \tau$. For smaller values of $\tau$, the correlation function increases, indicating that the scattered intensity is correlated.

The time difference at which the correlation function transitions from being correlated to being uncorrelated is related to the molecular diffusion coefficient. Small particles diffuse rapidly giving to rapid fluctuations of the scattered light which will have a short correlation time. Correspondingly, large particles diffuse slowly and have a long correlation time.

See the DYNAMICS User's Guide for a more detailed explanation of the physics of QELS.

5.3.3 Integration Time

Integration Time is the QELS sample rate, in seconds, of each QELS measurement. The integration time can be set in increments of the minimum time of 0.105 seconds. Integration times of up to 3600 seconds can be set, but are rarely used. Typical values range up to 10 sec. The instrument will round off the set time to the nearest multiple of 0.105 sec. The collection rate depends on the sample concentration and molecule size. In general, the value chosen should be proportional to expected size, times the concentration. If one has a concentrated sample and a small size, one should choose a sample rate of 1 second. Otherwise, longer sample times should be chosen to improve the measurement statistics.

The integration time selects the time for each measurement. The correlation function measurement is averaged for a time equal to the integration time. The longer the integration time, the more accurate is the result. However, if one sets a long integration time, the probability of the measurement being contaminated by dust increases.

As an aid to setting the integration time, intermediate results are displayed in red every one second. They get progressively more accurate (less noisy) as time progresses. After the measurement is complete, it is plotted in blue, and the new intermediates are plotted. The slider on the bottom shows the percent complete of the measurement.

Delay Time

The delay time is the horizontal axis of the correlation function graph. It is always less than the integration time.
5.3.4 APD Status

The avalanche photodiode (APD) contains an internal Peltier cooler that cools the active element to provide improved performance. When it is first powered on, the detector is especially susceptible to damage from over-illumination.

The Wyatt QELS is equipped with an APD protection circuit that will shut off the APD in the event of over illumination. The correlator hardware continuously monitors the count rate of the APD. If, at any point, it exceeds 10MHz, for more than 1 msec, it will shut down the detector to prevent damage. This is referred to as an APD alert. It will automatically restart during the next measurement.

Caution! Room light can damage the QELS detector, so it is important to power off the DynaPro NanoStar anytime you are making connections to the instrument, especially if there is the potential to expose the APD to light.
5.4 Alarm Panel

The Alarm panel displays sensor information and lets you adjust alarm settings. An alarm history is shown of the last few alarms and the time at which they occurred.

To turn off, enable, or disable the audio alarm, display the Alarm Panel, Tab to the Audio Alarm field, then Enter to toggle the option.

- **Auto Attenuating** is triggered when the door is closed and the auto attenuation switch is set. (See See “System Panel” on page 5-11.) The alarm is active during this process, which can take up to 2 seconds.

- **Overheat** is triggered if the read head ever exceeds 170°C

- **Cell temperature lock** shows if the cell temperature is locked

- **N2 pressure** is triggered when the temperature is set to less than 20°C, but the nitrogen pressure is less than 20 psi. In this case, the alarm activates and resets the system temperature to 20.5°C. This prevents condensation from damaging the optics if the nitrogen connection is not made, or if the tank runs empty.

- **Laser Monitor**: If the Laser Monitor signal differs from the Laser Power set point by more than 10% the Laser Monitor alarm will activate. The laser may have reached the end of its useful lifetime.

- **Laser Interlock**: The laser interlock switch is activated indicating that the lid is open.

- **Disposable Cuvette**: indicates that the disposable cuvette adapter block is installed in the sample cell and the temperature will be limited to no more than 80°C to avoid damage to plastic cuvettes.
5.5 System Panel

The System panel contains additional options for some of the selections on the Main panel.

![System Panel](image)

**Figure 5-8: System Panel**

### 5.5.1 Cell Temperature

The cell temperature displays the measured temperature of the sample cell. You can set the temperature by selecting the **Set to** field, typing the desired value, then Enter. The sample cell can be cooled or heated, between +4 and +150°C.

### 5.5.2 Attenuator

You can select Auto Attenuate or manually set an Attenuation factor. During Auto Attenuate, the system adjusts the fiber attenuator and laser intensity to give optimal signal levels for a given sample concentration. Weakly scattering samples will have maximum laser power and minimum fiber attenuation to give the best sensitivity. Strongly scattering samples are attenuated to prevent the detector from saturating. This gives the instrument the widest range of size and concentration.

### 5.5.3 Auto Attenuate

The auto attenuation algorithm adjusts the laser intensity to ensure that the static scattering signal is on scale (less than 10V). Since the SLS detector has such a wide range, this usually means that the laser is left at 100%.
Next the fiber attenuator is adjusted to put the DLS detector on scale. The target count rate is set by parameters in the firmware, but can be changed if necessary. Factory default is set to one Mcps. Please contact technical support at Wyatt Technology for more information.

If the fiber attenuator reaches its maximum attenuation (99.999%), then the laser power is reduced further until it reaches 10% laser power.

5.5.4 Laser Power (%)

You can control the laser power if this function is enabled (internal jumper control). This control is greyed out if the function is not enabled.

Although you can set the laser power below 10%, it isn't recommended. The problem is that if the laser drops below the lasing threshold, it will continue to produce light as an LED, but the results could be inaccurate because the LED light is not as monochromatic nor as well polarized as the laser.

5.5.5 Set Time

Set Time sets the time displayed in the X-axis of the graph.

5.5.6 Language

You can set the language of the user interface to English or other supported languages.

5.5.7 Zero Dark Offsets

The DynaPro NanoStar measures the dark offsets of the detectors, the Laser Monitor, and the Forward Monitor. It does this by turning the laser off for 10 seconds, measuring the dark offsets, and readjusting the offset for each detector so that dark measures as 0.

5.5.8 Restart ISI

Restart ISI is used to restart or reset the instrument communication in the event that a remote client, such as DYNAMICS or the Diagnostic manager, loses its communication to the instrument.

5.5.9 Load Factory Defaults

Load Factory Defaults is used to reset the instrument to the settings installed when the instrument was shipped.

5.5.10 Restart Instrument

Restart Instrument turns off the DynaPro NanoStar and turns it back on. This is typically used only when installing a firmware update.
5.6 Comm Panel

The Comm panel allows you to connect to a computer network.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Wyatt-101-DPN</td>
</tr>
<tr>
<td>IP address</td>
<td>172.20.2.65</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>Mode</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

Figure 5-9: Comm

**Obtain an IP address automatically** - Once the instrument is connected to a computer or LAN, the IP address and subnet mask will be assigned automatically. This option requires that the network has a DHCP server. When using DHCP, it may take several minutes for the IP address to be assigned. During this time, the IP address and subnet mask will read 0.0.0.0. Once the IP address and subnet mask have been assigned, both will be automatically updated, and should no longer read 0.0.0.0. At this point, it should be possible to connect to the instrument from the computer.

**Use the following IP address** - If you wish to use a static IP address and subnet mask, please contact your IT department to obtain a valid address and mask. Enter the information into the IP address and subnet mask fields.
This chapter describes how to prepare samples for light scattering measurements. As you will soon discover, the light scattered from a solution of particles is very sensitive to sample impurities and dust. It is important to develop standard procedures for preparing samples and collecting measurements.

**CONTENTS**

6.1 Cleaning the Cuvette .......................................................... 6-2  
6.1.1 Cleaning Tips .................................................................. 6-2  
6.2 Filtering Samples ................................................................. 6-3  
6.2.1 Filtering Options .............................................................. 6-3  
6.3 Spinning the Sample.............................................................. 6-4  
6.4 Filling the Cuvette ............................................................... 6-4  
6.4.1 Loading Tips .................................................................. 6-4  
6.6 Sample Preparation Troubleshooting ................................. 6-6
Chapter 6: Preparing Samples

6.1 Cleaning the Cuvette

Light scattering measurements are extremely sensitive to the presence of dust and/or non-miscible impurities in the sample solution. It is imperative that the light scattering cuvette be clean and dust free prior to sample loading.

Recommended cleaning procedures for the quartz cuvettes used in DynaPro NanoStar instruments are as follows.

1. Using a plastic transfer pipette, flush the cuvette multiple times with a mild surfactant or soap solution, for example, 1% Triton X 100, to remove any dust and/or residual impurities from the interior cuvette surfaces.

2. Rinse the cuvette several times with filtered deionized water.

3. With the cuvette in an inverted position, dry the interior using filtered dry compressed air.

4. Check the exterior surface of the cuvette windows, and remove any smudges or fingerprints using a clean piece of lens paper. Note, that tissues and other laboratory wipes can scratch the surface of the cuvette and are not recommended.

5. Using filtered dry compressed air, remove any dust from the surface of the cuvette cap, replace the cap, and then set the cuvette aside until ready for use.

6.1.1 Cleaning Tips

- One cleaner we have had good success with is Hellmanex. See http://www.hellma-worldwide.com/text/197/en/hellmanox%C2%AE-ii.html.

- Concentrated acids and bases can etch the cuvette surface and are not recommended.

- Organic solvents have been known to leave a thin residue on the cuvette surface. Hence, the use of acetone or ethanol as a means of drying the cuvette interior is not recommended unless they are of very high purity.

- If the cuvette is still not clean after flushing with soap, as a last resort one may use an ultrasonic cleaner. The ultrasonic cleaner can cause the sintered seams of the cell to break although this is very rare.
6.2 Filtering Samples

The question of whether or not to filter a sample is commonly raised by researchers using light scattering instrumentation. The standard argument is that "if I filter my sample, I'm not really measuring the original sample." To a very limited extent, this argument is correct, and if you want to see whether or not you've got some very large "stuff" in your sample, then you should avoid filtering. It must be recognized however, that very large stuff includes dust, which really isn't an integral component of the analyte. If you find yourself questioning whether or not to use a filter, remember the following:

- The upper size limit for dynamic light scattering is dependent upon a variety of factors, principle of which is the diameter of the laser beam in the scattering volume. The beam size is set to 80μm so that we can measure above 1μm. If you operate at very low concentration, it is worth computing how many particles are in the beam at once. If the particles that you're attempting to measure are big, compared to the beam diameter, you're likely to encounter number fluctuations, which means that the number of particles within the scattering volume during the course of the measurement is not constant. While the presence of number fluctuations will tell you that you have large particles in the sample, you will not be able to get a size or mass distribution.

- Dust or non-sample contaminants are typically very large, and can usually be removed with a 0.45 μm filter. For smaller size analytes such as proteins, the pore size for this filter is sufficiently large to pass all of your true sample.

- If you're working with larger particles, such as gold and silver colloids, macromolecular assemblies, and (some) polymers, the scattering from the sample itself is sufficient to counter any scattering contribution from dust particles (assuming reasonable care is taken during your sample preparation, such as filtered solvent, clean cuvette, etc.). As such, number fluctuations arising from dust are less likely to be observed, since the scattering contribution is virtually negligible.

- The upper size range limit for the DynaPro NanoStar is 1 μm radius.

6.2.1 Filtering Options

If you need to filter your sample, you have several options:

- If you have less than 300 μL of sample to use for a light scattering measurement, then use the NanoFilter, with a dead volume less than 5 μL. Precious sample loss is minimized. In addition, the NanoFilter has been designed to make sample recovery and refiltration simple.

- If you have more than 300 μL of sample, use a traditional syringe filter. Traditional disposable syringe filters are easier to use than the NanoFilter, and it is not necessary to clean them before use.
Chapter 6: Preparing Samples

6.3 Spinning the Sample

Rather than filtering, many DynaPro NanoStar users prefer to centrifuge their samples. As a consequence of the centripetal force, larger dust particles migrate to the bottom of the centrifuge tube, thereby eliminating the need to remove the dust particles via standard filtration techniques. Recommended spin rates and times vary with the sample. However, 10-15 minutes at 3000 RPM is typical. When removing the sample for loading, remember that only the top portion of the sample is dust free.

Because of the volume control, a Pipetman works best for transferring the sample from the centrifuge tube to the cuvette. Dust can be removed from the pipette tip with filtered dry compressed air.

6.4 Filling the Cuvette

The sample is loaded into the DynaPro NanoStar cuvette by placing the needle or pipette tip all the way to the bottom of the cuvette and dispensing the specified volume of sample. Be careful not to scratch the cuvette window when placing the needle into the cuvette.

Note that the standard cuvette is 10μl (1x1x10 mm), You need to fill the cell with enough sample to avoid a meniscus in the cell, up to 20μl, or you can cover the sample with a small quantity of mineral or silicone oil. The oil will also prevent evaporation when operating at high temperatures.

6.4.1 Loading Tips

• If you encounter bubble problems, try slowly pulling the needle tip upwards as the sample is dispensed.

• While not pictured above, a 100 μL pipetman with capillary tips also works well for loading cuvettes, especially if you choose to centrifuge, rather than filter your sample. If you use a pipetman, it’s recommended that you blow any dust out of the tip with compressed air, prior to filling with sample.

• The bowl at the top of the cuvette window tends to collect dust. We recommend that you place only enough sample in the cuvette to fill the window.
6.5 Loading the DynaPro NanoStar

When loading the cuvette into the DynaPro NanoStar, you should note that there is one flattened corner on the cuvette. This corner of the cuvette must be positioned to the left front side of the optics block.

NOTE: Close the lid of the DynaPro NanoStar gently and slowly to avoid shaking the cuvette or sample. Do not slam the door.

After seating the cuvette in the DynaPro NanoStar optics block, gently close the lid to activate the laser. Once the lid is closed again, the laser is re-enabled. A warm up time of up to 30 seconds may be required before the laser is functional. If you are performing measurements at a temperature other than ambient, closing the cell lid will also restart the temperature lock timer. The temp lock light will go green after the cell has been within 0.05°C for two minutes. You are now ready to begin collecting light scattering data.

Figure 6-2: Loading the DynaPro NanoStar
6.6 Sample Preparation Troubleshooting

When I load the cuvette, I still occasionally get a bubble, even when pulling the needle tip upwards during loading.

This is a common problem with low-volume cuvettes. Try tipping the needle into one of the corners of the cuvette window. Also, insert the needle all the way to the bottom of the cuvette and slowly inject the sample. This “bottom up” approach helps avoid trapping air bubbles. Many times, that will ‘pop’ the bubble.

Tapping the cuvette gently against the tabletop can also help dislodge bubbles. Of course care must be taken not to damage the cuvette or to “splash” the sample.

Also avoid dripping the sample down the side of the ground glass inlet section of the cuvette, as this can sometimes introduce dust into an otherwise clean sample.

Bubbles are often a sign of a cell that is not scrupulously clean. If they are persistent, try cleaning the cell with Hellmanex. See “Cleaning Tips” on page 6-2.
This chapter describes how to prepare and fill the cuvette with a BSA sample and record data. It assumes you have set up the equipment, installed DYNAMICS software, and have the software and hardware up and running.

**CONTENTS**

7.1 Prepare and Fill Cuvette with BSA Sample ................................ 7-2
  7.1.1 Preparing the Cuvette .................................................. 7-2
  7.1.2 Filling the Cuvette ..................................................... 7-2
7.2 Load the Cuvette into the DynaPro NanoStar .......................... 7-3
7.3 Wait for Equilibrium ....................................................... 7-3
7.4 Check the Count Rates .................................................... 7-4
7.5 Record Data ................................................................. 7-4
7.6 Compare your Results ..................................................... 7-4
7.1 Prepare and Fill Cuvette with BSA Sample

Prepare a quartz cuvette for light scattering measurements as follows:

7.1.1 Preparing the Cuvette

1. Clean it thoroughly with a mild detergent and rinse with deionized water.
2. Dry with filtered dry compressed air.
3. Carefully break open the glass BSA Ampoule and transfer the BSA into an Eppendorf or vial with cap. Dispose of the glass ampoule.
4. Attach the enclosed syringe needle to the 1-ml syringe. Insert the syringe needle into the container of BSA, and extract approximately 100 μL of solution.
5. Remove the needle, attach a 0.02 μm filter to the syringe, replace the needle, and push out the air pocket.
6. Dispense 2-3 drops through the filter and needle into a waste container to remove any potential dust and/or bubbles from the interior of the filter and needle.

Figure 7-1: Removing the Needle

7.1.2 Filling the Cuvette

1. Hold the cuvette so that you can view the sample clearly.
2. Insert the syringe needle until it reaches the bottom of the sample chamber.
3. Dispense BSA into the chamber until it fills the aperture. It is okay to overfill the chamber; however, when working with precious samples you will want to avoid overfilling. If you have problems with bubbles, try placing the needle in a corner and slowly pulling the needle upward as you dispense the BSA into the chamber.

Figure 7-2: Cuvette
7.2 Load the Cuvette into the DynaPro NanoStar

Prior to loading the cuvette into the DynaPro NanoStar, wipe any fingerprints or dust from the cuvette, being careful to avoid scratching the surface. Lens paper is recommended.

Note that there is one flattened corner on the DynaPro NanoStar cuvette. When the cuvette is loaded, this corner of the cuvette must be positioned to the left front side of the optics block.

![Figure 7-3: Loading the DynaPro NanoStar](image)

When you're ready to begin data collection, close the lid to activate the laser.

7.3 Wait for Equilibrium

If your sample is being measured near room temperature it will take about two minutes to reach thermal equilibration and achieve temp lock. If your sample is being measured at a high or a low temperature, several minutes may be required to reach thermal equilibration.

While waiting, make sure the count rates are more than the pure solvent count rate by checking the count rate monitor.
Chapter 7: Collecting Data

7.4 Check the Count Rates

As a first step to recording data, we recommend viewing the count rate monitor to verify proper loading of the sample and cuvette. You check the count rate by clicking the button in the DYNAMICS menu bar to display the Instrument Control Panel.

Consult the Certificate of Performance that comes with your DynaPro NanoStar for count rates. If the counts are very low (below 1000): verify that the lid is closed; the cuvette is inserted with the frosted side to the left; and that the BSA is properly loaded, without any bubbles. Make sure the laser has warmed up sufficiently. Once the lid is closed and the laser is turned on, a wait time of up to 30 seconds may be required before the laser is functional.

If the counts are fluctuating by more than 20% then remove the cuvette and check for visible bubbles or floaters in the BSA sample. It may be necessary to clean the cuvette and reload the BSA. If the problem persists, continue with the next step, recording data, and email your data to Wyatt Technology for technical assistance.

7.5 Record Data

To begin recording data, click the green record button on the DYNAMICS toolbar. The button will then turn red, a new measurement will be added to the Tree View, and data will begin filling the table in the Grid View. The mean and standard deviation (S) for each column will be given in the Statistics Table. The buttons to the left of the Record button can be used to view the data in different display formats. After you've collected 20 sample acquisitions (Acq), click the red button to stop the data recorder, and select File→Save to save the data file.

7.6 Compare your Results

You can compare your BSA results to those on the certificate of performance shipped with instrument. In particular, the count rates and BSA radius should agree with the certificate of performance values to within 10%.

When finished, you can save your experiment using the File→Save command on the menu bar.
This chapter outlines easy maintenance guidelines that will help keep your DynaPro NanoStar instrument trouble free.

**WARNING!** The DynaPro NanoStar has no user serviceable parts. For your safety, do not dismantle the instrument. Do not bypass any of the safety systems and interlocks that are in place for your health. If the instrument is not functioning properly, do not apply power.

**CONTENTS**

8.1 Cuvettes .......................................................... 8-2
8.2 Outer Case .......................................................... 8-2
8.3 Inlet Air Filters ....................................................... 8-2
8.4 Cooling Precautions .................................................. 8-2
Chapter 8: Periodic Maintenance

8.1 Cuvettes

If the clean water count rate from the cuvette appears to be higher than normal after repeatedly flushing with water, clean the cuvette with a mild detergent solution and then rinse thoroughly with deionized water until the correct clean water count rate is reached. When they are not in use, two cuvettes can be stored in the door of the DynaPro NanoStar or in the boxes supplied.

8.2 Outer Case

Periodically wipe down the outside case of the instrument with a clean, moist cloth to keep it free from dust or surface stains.

8.3 Inlet Air Filters

Periodically change or clean the two inlet air filters on the back panel. They can be cleaned with mild soap and water. Make sure to let them dry completely before reinstalling. There are two filters on the back panel.

8.4 Cooling Precautions

The pattern of ventilation holes on the top of the instrument are cosmetic only. The air vents are all on the bottom. There is a cell fan that exhausts downwards, and a chassis exit vent that similarly exhausts under the computer. It is important that the DynaPro NanoStar not be stacked on other temperature sensitive equipment.

We recommend that any time a problem arises, you should turn off the instrument immediately to avoid any possible damage, and refer to this manual or contact Wyatt Technology to identify the problem and resolve it. Some errors can cause damage to the internal components if the user allows the instrument to be powered-up for extended periods of time before the problem is remedied.

If you find a problem that is not described in this manual, or if the suggestions given here don't appear to work, please contact Wyatt Technology.
The DynaPro NanoStar contains a GaAs laser operating at a nominal wavelength of 658nm.

The GaAs laser is a single transverse mode heterojunction that emits light at 658nm at a power of 120mW with 100mW delivered to the sample cell. Typically, diode lasers undergo periodic mode hops between different longitudinal modes which have slightly different efficiencies giving rise to sudden changes in intensity, however Wyatt Technology utilizes a patented intensity stabilization method which achieves a typical long term intensity stability of 0.1%.

It is suggested that the laser be allowed at least 30 minutes to warm up before taking data.

## CONTENTS

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1 Electrical and Optical Specifications</td>
<td>A-1</td>
</tr>
<tr>
<td>A.2 Environmental Specifications and Safety Notes</td>
<td>A-2</td>
</tr>
</tbody>
</table>

### A.1 Electrical and Optical Specifications

*Table A-1: Electrical and optical specifications*

<table>
<thead>
<tr>
<th>Specification</th>
<th>GaAs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Output</td>
<td>100 mW</td>
</tr>
<tr>
<td>Laser Operating Wavelength</td>
<td>658 nm</td>
</tr>
<tr>
<td>Vertical Beam 1.0/e^2 Intensity Diameter</td>
<td>80 μm</td>
</tr>
<tr>
<td>Horizontal Beam 1.0/e^2 Intensity Diameter</td>
<td>52 μm</td>
</tr>
<tr>
<td>Polarization Ratio</td>
<td>&gt; 100:1</td>
</tr>
<tr>
<td>Power Stability</td>
<td>&lt; 0.5%</td>
</tr>
<tr>
<td>Typical Optical Noise</td>
<td>&lt; 0.1%</td>
</tr>
<tr>
<td>Typical Operating Voltage</td>
<td>2.4 VDC</td>
</tr>
<tr>
<td>Typical Operating Current</td>
<td>100 mA</td>
</tr>
</tbody>
</table>
A.2 Environmental Specifications and Safety Notes

Table A-2: Laser Environmental specifications

<table>
<thead>
<tr>
<th></th>
<th>GaAs Operating(^a)</th>
<th>GaAs Non-Operating(^b)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature</strong></td>
<td>-40 to +85°C</td>
<td>15 to +50°C</td>
</tr>
<tr>
<td><strong>Relative Humidity</strong></td>
<td>0-95%</td>
<td>10-85%</td>
</tr>
<tr>
<td><strong>Shock</strong></td>
<td>1500 g - 0.5 ms</td>
<td>1500 g - 0.5 ms</td>
</tr>
<tr>
<td><strong>Vibration</strong> (5 to 500Hz sinusoidal)</td>
<td>2.0 g</td>
<td>2.0 g</td>
</tr>
</tbody>
</table>

\(^a\) Operating refers to when the power is on.
\(^b\) Non-operating refers to when the instrument is being shipped or in storage (i.e., powered off).

The lasers used in the DynaPro NanoStar are Class IIIb lasers. However, the DynaPro NanoStar itself is classified as a Class 1 Laser Product according to IEC60825-1:1993+A1+A2 and CFR Title 21 Subchapter J. Note these environmental specifications apply to the laser subsystem and not to the instrument as a whole. This means that under normal operation, no laser radiation should escape from the instrument, and no protective equipment must be worn. However the follow cautions apply:

- **Caution!** Use of controls or adjustment or performance of procedures other than specified herein may result in hazardous radiation exposure.
- **Caution!** Do not attempt to defeat laser interlocks. Do not insert finger or mirror into sample cell cavity for any reason.

**NOTE:** Laser safety labels are in English. If you need safety labels in a language other than English, please contact Wyatt Technology.
Connecting to Network or PC

These instructions contain a pictorial overview for connecting your DynaPro NanoStar to a computer for data collection. The instructions are divided into six sections:

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.1 Components</td>
<td>B-2</td>
</tr>
<tr>
<td>B.2 Connecting to a LAN</td>
<td>B-9</td>
</tr>
<tr>
<td>B.3 Connecting via USB</td>
<td>B-13</td>
</tr>
<tr>
<td>B.4 Connecting via Ethernet when not on a LAN</td>
<td>B-16</td>
</tr>
<tr>
<td>B.5 Instrument Network Settings</td>
<td>B-19</td>
</tr>
<tr>
<td>B.6 Trouble-shooting and diagnostics</td>
<td>B-20</td>
</tr>
</tbody>
</table>

Please read over Section B.1 to gain an understanding of the components to be used. Then read over either Section B.2, B.3, or B.4 depending on your configuration. Finally, read over Section B.5 for instrument settings.

If you experienced problems connecting to your instrument, please read Section B.6 for diagnostics and trouble-shooting.
Appendix:

B.1 Components

B.1.1 Instrument connections:

Figure B-1 is a detail of the instrument back panel. The Ethernet port, designated with a yellow arrow, is to be used for all connections in these instructions. Please see Section B.3 for instructions on establishing a USB connection.

Figure B-1: Detail of the back panel of the DynaPro NanoStar. The yellow arrow designates the Ethernet port.
B.1.2 LAN connection:

Figure B-2 shows a typical wall socket connection to a Local Area Network (LAN). If you are going to connect the instrument to a LAN, you will need access to this type of socket.

Figure B-2: Wall socket LAN connection indicated by yellow arrow.
B.1.3 Computer connections:

Computer connections can be made via either the Ethernet or USB port. Figure B-3 shows these ports on a standard laptop computer. Sections B.2 and B.4 describe instrument connections made via the Ethernet port. Section B.3 describes connections made via the USB port.

Figure B-3: Ethernet and USB ports on the computer.

The USB ports are designated by a green arrow, and the Ethernet port is designated by a yellow arrow.
B.1.4 Crossover cable:

A crossover cable can be used to make a direct connection from the instrument to an Ethernet port on a computer or to an Ethernet to USB adapter. Please note that the crossover cable shipped with Wyatt Technology instruments is yellow to distinguish it from a standard Ethernet cable. Please be careful to only use the yellow crossover cable where indicated.

Figure B-4: The Ethernet crossover cable shipped by Wyatt Technology is yellow.
B.1.5 Ethernet cable:

A standard Ethernet cable is sometimes referred to as a patch cable, or a straight-through cable to distinguish it from the crossover cable in Section B.1.4. Ethernet cables provided by Wyatt Technology are black, blue, white, or gray, but never yellow (yellow is reserved for the crossover cable). For these instructions, the Ethernet cable will always be black.

Figure B-5: Standard Ethernet cable.
For these instructions, the standard cable is always black.
B.1.6 Ethernet to USB adapter:

This device can be used to connect an Ethernet cable to a USB port on the computer. Using this adapter, it is possible to have the computer connected to a LAN via the computer's Ethernet port, and the instruments connected to the computer via USB. The Ethernet to USB adapter supplied by Wyatt Technology will look similar to this. The first time you connect an Ethernet to USB adapter to your computer, you may be prompted to install USB drivers for the device. To do so, use the CD supplied with the Ethernet to USB adapter, and follow the Microsoft Windows instructions.

Figure B-6: Standard Ethernet to USB adapter. The Ethernet cable is plugged into the port with the yellow arrow, and the USB plug (green arrow) is plugged into a USB port on the computer.
B.1.7 Ethernet switch:

Ethernet switches are used to connect several Ethernet cables to one resource, such as the LAN socket in Figure B-2. The Ethernet switch supplied by Wyatt Technology will look similar to the five port switch shown below. Please note that Ethernet cables can be connected to the switch in any order or position. Also, the switch has an external AC adapter (not shown) to provide power to the switch.

Figure B-7: Five-port Ethernet switch.
B.2 Connecting to a LAN

If an instrument is connected to a LAN, it can be accessed by any computer plugged into the same LAN.

B.2.1 One instrument to LAN:

Plug the instrument into a LAN wall socket using a standard Ethernet cable. The computer that is to communicate with the instrument must be on the same LAN.

Figure B-8: Connection for one instrument to LAN.

NOTE: This view is the back panel of the ViscoStar, but the same connection method is used by the DynaPro NanoStar.
B.2.2 One instrument and computer to LAN:

If there is only one LAN wall socket available for both the instrument and computer, it is necessary to use an Ethernet switch to connect both the computer and instrument to the LAN. In this configuration, the computer can access the LAN and the instrument, and the instrument can be accessed from any other computer on the LAN.

Figure B-9: One instrument and a computer can both be connected to the LAN using an Ethernet switch.
B.2.3 Multiple instruments to LAN:

If there is only one LAN wall socket available, two or more instruments can be connected to the LAN via an Ethernet switch. The instruments can be accessed via any computer on the LAN.

![Image of two instruments connected to the LAN via an Ethernet switch.]

*Figure B-10: Two instruments connected to the LAN via an Ethernet switch.*
B.2.4 Multiple instruments and computer to LAN:

If there is only one LAN wall socket available for multiple instruments and a computer, it is necessary to use an Ethernet switch to connect both the computer and instruments to the LAN. In this configuration, the computer can access the LAN and the instruments, and the instruments can be accessed from any other computer on the LAN.

Figure B-11: Two instruments and a computer connected to the LAN via an Ethernet switch.
B.3 Connecting via USB

If it is not possible or desired to have the instruments connected to a LAN, it is possible to connect to the instruments via USB. In this way, the instruments can be isolated from the LAN, even while the computer maintains its own Ethernet connection with the LAN.

B.3.1 One instrument to USB via a crossover cable:

Connect the yellow crossover cable from the instrument to the Ethernet to USB adapter. Plug the Ethernet to USB adapter into an available USB port on the computer. You may be prompted to install drivers for the Ethernet to USB adapter the first time it is plugged into the computer. To install the drivers, insert the CD that came with the adapter and follow the Windows instructions.

Please note that the network communication setting in the Communications tab of the instrument display is Ethernet for this configuration, and not USB Virtual Ethernet.

Figure B-12: One instrument to USB via yellow crossover cable.
B.3.2 One instrument to USB using an Ethernet switch:

Connect the instrument to the Ethernet switch using a standard Ethernet cable. Then connect the Ethernet switch to the Ethernet to USB adapter using a standard Ethernet cable. Plug the Ethernet to USB adapter into an available USB port on the computer. You may be prompted to install drivers for the Ethernet to USB adapter the first time it is plugged into the computer. To install the drivers, insert the CD that came with the adapter and follow the Windows instructions.

Figure B-13: Connecting one instrument to USB using an Ethernet switch.
B.3.3 Multiple instruments to USB:

Two or more instruments can be connected to USB using an Ethernet switch. Use a standard Ethernet cable to plug each instrument into the Ethernet switch. Then connect the Ethernet switch to the Ethernet to USB adapter using a standard Ethernet cable. Plug the Ethernet to USB adapter into an available USB port on the computer. You may be prompted to install drivers for the Ethernet to USB adapter the first time it is plugged into the computer. To install the drivers, insert the CD that came with the adapter and follow the Windows instructions.

Figure B-14: Connecting two or more instruments to USB using an Ethernet switch and Ethernet to USB adapter.
B.4 Connecting via Ethernet when not on a LAN.

If the computer is not on the LAN, it is possible to use the Ethernet port directly to connect to the instruments.

B.4.1 One instrument to computer not on LAN using crossover cable:

Connect the yellow crossover cable from the instrument directly to the Ethernet port on the computer.

Figure B-15: Connecting one instrument directly to a computer that is not on the LAN using the yellow crossover cable.
B.4.2 One instrument to computer not on LAN using an Ethernet switch:

Connect the instrument to the Ethernet switch using a standard Ethernet cable. Then connect the switch to the computer Ethernet port using a standard Ethernet cable.

*Figure B-16: Connecting one instrument to the computer using an Ethernet switch.*
B.4.3 Multiple instruments to computer not on LAN using an Ethernet switch:

Connect each instrument to the Ethernet switch using a standard Ethernet cable. Then connect the switch to the computer Ethernet port using a standard Ethernet cable.

Figure B-17: Connecting multiple instruments to a computer not on the LAN using an Ethernet switch.
B.5 Instrument Network Settings

Figure B-18 shows the standard settings on the instrument front panel that will work with all of the above connection schemes.

As shown in Figure B-18, to set the IP address there is a choice of **Obtain an IP address automatically**, to use an associated DHCP server, or **Use the following IP address**: to set a static IP address. In general, this setting can be left to DHCP. With DHCP, once the instrument is connected to a computer or LAN, the IP address and subnet mask will be assigned automatically. This will even work with the USB connections described in "Connecting via USB" on page B-13. When using DHCP, it might take several minutes for the IP address to be assigned. During this time, the IP address and subnet mask will read 0.0.0.0. Once the IP address and subnet mask have been assigned, both will be automatically updated, and should no longer read 0.0.0.0. At this point, it should be possible to connect to the instrument from the computer.

If you wish to use a static IP address and subnet mask, please contact your IT department to obtain a valid address and mask.

![Instrument Network Settings](image)

*Figure B-18: Standard settings for instrument connectivity.*
B.6 Trouble-shooting and diagnostics

If you are experiencing instrument connectivity problems, please go over these steps. If you still cannot connect to your instrument after going over this section, please contact Wyatt Technology for assistance or visit www.wyatt.com for the latest troubleshooting guides.

B.6.1 Verifying instrument connections

Please verify that the instrument is communicating with the computer. Open a Windows cmd prompt, as shown in Figure B-19. At the command line, type "ping" plus the IP address of the instrument as shown on the instrument front panel (see Figure B-18). If the instrument is connected properly, the result should be similar to that shown in Figure B-19.

```
C:\> ping 172.20.1.244
Pinging 172.20.1.244 with 32 bytes of data:
Reply from 172.20.1.244: bytes=32 time<1ms TTL=128
Reply from 172.20.1.244: bytes=32 time<1ms TTL=128
Reply from 172.20.1.244: bytes=32 time<1ms TTL=128
Reply from 172.20.1.244: bytes=32 time<1ms TTL=128
Ping statistics for 172.20.1.244:
    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
    Approximate round trip times in milli-seconds:
        Minimum = 0ms, Maximum = 0ms, Average = 0ms
```

Figure B-19: Using ping to verify the instrument connection.

If the instrument is not connected properly, the result should be similar to that shown in Figure B-20.

```
C:\> ping 172.20.1.243
Pinging 172.20.1.243 with 32 bytes of data:
Request timed out.
Request timed out.
Request timed out.
Request timed out.
Ping statistics for 172.20.1.243:
    Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),
```

Figure B-20: Failure to connect to instrument using ping.
Index

A
alarm
  auto attenuating 5-10
  disposable cuvette 5-10
  enabling 5-3
  N2 pressure 5-10
  overheat 5-10
  turn off 5-3
alarm history 5-10
alarm panel 5-10
American National Standards Institute 2-1
APD 5-9
  over illumination 5-9
  protection system 5-9
audible alarm 5-3
audio alarm
  disable 5-10
  enable 5-10
  turn off 5-10
autocorrelation 1-4
avalanche photodiode (APD) 5-9

B
back panel 3-3
block Diagram 1-2
BSA Sample 7-2
bubble problems 6-4
bubbles, detecting 3-10

C
calibration 4-7
case maintenance 8-2
CD Contents 4-2
cell temperature 5-11
cell temperature lock 5-10
centrifuge 6-4
changing a fuse 3-3
cleaning procedures
  cuvettes 6-2
Comm panel 5-13
  DCHP 5-13
Connect to Hardware button 1-3, 4-9
connecting to LAN B-3
connecting to network B-1
connecting to PC B-1
connecting via USB B-13
connectors
  back panel 3-3
  Nitrogen Purge 4-5
contact information 1-5
contaminants 6-3
correlation function, QELS 5-8
Count Rates 7-4
cover 3-4
crossover cable B-5
Cuvette
  filling 6-4, 7-2
  flattened corner 6-5, 7-3
  loading into DynaPro NanoStar 7-3
  maintenance 8-2
  preparing 7-2

D
Data
collecting 7-1
recording 7-1, 7-4
DHCP 5-13, B-19
diagnostics
  www.wyatt.com B-20
display
  adjusting the display range 5-5
  alarm panel 5-10
  autoscale 5-6
  button description 5-2
  cell temperature 5-11
  Comm panel 5-13
  main 5-2
  navigating 5-2
  setting the scale 5-6
  system panel 5-11
display. See LCD display
dust, detecting 3-10
DYNAMICS
  connecting to DynaPro NanoStar 4-8
  installing 4-2, 4-3
  software description 1-2
DynaPro NanoStar
  adjusting the display range 5-5
  cell temperature lock 5-10
  connecting to B-1

DynaPro NanoStar (M3300 Rev. A)
Index

connecting via USB B-13
display window 5-1
LAN connection B-3
load factory defaults 5-12
loading 7-3
network settings B-19
operations 1-4
overview 1-1
restart instrument 5-12
restart ISI 5-12
setting cell temperature 5-6
warning lights and alarms 5-3
zoom/pan buttons 5-5

E
electronic fuse 3-3
environment
  location 4-4
equipment list 4-1
ethernet cable B-6
ethernet connection
  multiple instruments B-18
  one instrument B-17
ethernet crossover cable B-5
ethernet port B-2
ethernet switch B-8
Experiment
  Parameters 4-10
  starting new 4-8

F
Filling
  cuvette 6-4
Filtering samples 6-3
forward laser monitor 3-10
front panel 3-2
fuses
  replacing 3-3

H
Hardware
  checking configuration 4-6
  verifying 4-10
hazards, definitions of 2-1
Humidity
  controlling 3-8

I
Installation and Setup 4-1
Installing DYNAMICS 4-3
instrument connections B-2
  verifying B-20
Instrument Detection screen 4-6

K
kepad 3-2

L
LAN connection
  multiple instruments B-11
  multiple instruments and computer B-12
  one instrument B-9
  one instrument and computer B-10
language 5-12
laser
  beam size 6-3
  current monitor 3-10
  description 3-9
  forward monitor 3-10
  monitor 3-10
  monitor values 3-10
  monitors 3-10
  On/Off 5-6
  specifications A-1
  warning 3-9
laser drive current 3-10
laser monitor
  values 3-10
LCD display 3-2
load factory defaults 5-12
location 4-4

M
Maintenance 8-1

N
network settings B-19
Nitrogen Purge fitting
  connecting 4-5
On/Off switch 3-2

O
packing list 4-1
Parameters
  experiment 4-10
particles
  detecting 3-10
parts list 4-1
Peltier cooler 5-9
power switch 3-2
Precautions 8-2

Q
QELS
  correlation function 5-8
  sample rate 5-8

Index-2
R
read head 3-11
detectors 3-11
Record button 1-3
Recording data 7-4
restart instrument 5-12
restart ISI 5-12
Restricted Privileges 4-2

S
Samples
BSA 7-2
filtering 6-3
preparing 6-1
spinning 6-4
setting cell temperature 5-6
shipping list 4-1
size range limit 6-3
software
DYNAMICS 4-7, 5-8
establishing communications 4-7
installation 4-2
specifications
laser A-1
Static IP B-19
static IP address 5-13
system panel 5-11
System Requirements 4-2

T
Temperature
accuracy 3-5
automating 3-6
range 3-5
setting 3-6
target 3-6
time to stabilize 3-7
Temperature Controlled 3-1
top cover 3-4
transmitted light 3-10
troubleshooting
www.wyatt.com B-20

U
Unpacking 4-1
USB adapter B-7
USB connection
multiple instruments B-15
one instrument B-14
via crossover cable B-13

V
ventilation holes 8-2

W
warm up time 4-5
warning lights and alarms 5-3
Wyatt Technology Corporation
contact information 1-5
corporate headquarters 1-5

X
X-axis
selector 5-4
set time 5-12

Y
Y-axis data channel 5-4

Z
zoom/pan buttons 5-5